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Getting Started 

 

What is CoolMap? 

 

CoolMap is an interactive data visualization approach that brings the classic heatmap 

visualization paradigm into the era of big data. It dynamically condenses large unmanageable data 

sets into smaller and more understandable views based on well-established conceptual frameworks 

such as gene and phenotype ontologies while preserving the capability to examining the original data 

at any level of detail in their context.  

In order to use the CoolMap approach effectively for the exploration and analysis of large 

omics data sets, we developed the CoolMap application to integrate the CoolMap visualization with 

statistical analysis in R, network/pathway visualization in Cytoscape and genome browsing in the 

Integrative Genomics Viewer.  Users and third party developers can also enhance the CoolMap 

application by incorporating/sharing their own custom R-scripts as well as new plug-ins for 

CoolMap.  

What can users accomplish with the program? 

CoolMap is designed to facilitate the biological interpretation of large omics data sets including 

but not limited to: 

• Quickly identify interesting data points in a large data set 

• Associate molecular level data to high level biological concepts 

• Linking statistical test results to sample level data for validation 

• Explore patterns and relationships amongst different data points in their context 

• Statistical testing of potentially interesting relationships and patterns 

• Examining data from different perspectives: network/pathway, genome 

• Integration of different data sets across CoolMap, Cytoscape and IGV. 

What makes this program unique when compared to other programs? 

 The utilization of a dynamic heatmap as the starting point for visual data exploration and 

analysis is the most distinctive feature of the CoolMap application.  It facilitates the association of 

large omics data sets   with high-level biological concepts for hypothesis development while making 

large data sets more manageable. The CoolMap application is also unique in providing a platform 

that integrates interactive visual explorations in CoolMap, Cytoscape and IGV with statistical 

analysis in R, enabling the efficient execution of a wide variety of exploratory data analysis tasks 

across these programs. The novel data list streaming capability in the CoolMap application converts 

the tedious manual gene-by-gene examination of features/patterns/functions associated with top-
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ranked gene lists into a fully controllable data video, greatly increased the efficiency of candidate list-

based analysis tasks such as validation and hypothesis development.  

 CoolMap complements other comprehensive omics data analysis solutions such as 

GenePattern, Galaxy and GenomeSpace, by providing better support for data interpretation driven 

activities.  Our long term goal is to enable researchers to use biological questions identified through 

CoolMap to refine data analysis in solutions like GenePattern and Galaxy to achieve seamless 

integration of number crunching and the interpretation of the crunched numbers. 

What are the benefits of using CoolMap?  

 The CoolMap application provides unprecedented power for exploratory analysis of large 

omics data sets. It can help biologists and data analysts to link their data and analysis results to 

biological contexts for biological interpretations and hypothesis development.  It can bring more 

biology for refining statistical analysis as well as making raw data and analysis methods more 

accessible to biologists. The power of the CoolMap application can also be greatly enhanced by third 

developers through R scripts and plug-ins.  



 

CoolMap Installation 

 

What are the System Requirements? 

The CoolMap application is a Java program that can run on Windows 7 or later and Mac OS 10.9 or 

later with Java 7 or later runtime environment. JRE 7 is preferred since the current version of 

CoolMap was developed and tested with Java 7.  We have not tested CoolMap under the Linux 

environment although most of its functions should also work.  

Computers running CoolMap should have Intel i5 class processor or better and at least 8 GB of 

memory. Dual monitors are highly recommended. Quad monitor setup will make data exploration 

and analysis much more efficient if you plan to use CoolMap together with R statistical analysis, 

Cytoscape and Integrated Genomics Viewer at the same time.  

How can I download CoolMap? 

The CoolMap program is available under the Download menu at coolmap.org as a Zip archive file. 

For new users, a simple registration is needed. All future downloads only requires your registered e-

mail address. 

  

How can I install CoolMap? 

 

For Mac users: 

 

 For best results, the CoolMap program should be utilized in the latest Mac OS environment- 

specifically any 10.9.x system or newer.  The following steps below should be followed in order to 

ensure that the program works efficiently on Mac laptop and desktop systems. 
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Within the Mac OS environment, a native Zip file extractor exists which can expand the file 

archive.  From within Finder, the default file managing system in the Mac OS environment, select 

the Download folder. 

 

 

The Zip archive is already extracted into a folder titled “dist.”  This folder can be renamed to 

CoolMap and moved to the Applications folder. 

 

 

 After downloading and extracting the CoolMap file, make certain that your Mac is running 

the latest version of the Java runtime environment.  The most reliable downloads for Java can be 

located at: 

http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html  
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Select the 64 bit download file for the Mac OS Java runtime environment and install the file. 
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After the Java runtime environment has been installed on your computer, open the “CoolMap” 

folder and double click on “CoolMap.jar” in order to open the program. 

 

 

For PC users: 

 

Once the CoolMap zip file is downloaded, you can use the Windows unzip it to a new folder you 

designated. Here we call the new folder “CoolMap” 
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After the extraction is done, there will be a CoolMap Executable Jar File and a plugin folder in the 

CoolMap folder. Double the CoolMap.jar file (highlighted in the following screen capture) in the 

CoolMap folder will start the CoolMap application. 

 

 

 

Since the real power of the CoolMap application is its ability to work with other data exploration 

and analysis solutions, we highly recommend you to continue the installation process to make 

CoolMap interoperable with Cytoscape, R statistical environment and the Integrated Genomics 

Viewer. 

How to Use the Cytoscape Reactome FI App with CoolMap? 

 

1. Download and install latest Cytoscape at http://www.cytoscape.org/.  
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2. Go to Cytoscape installation folder (on PC, it’s usually ‘C:/Program 

Files/Cytoscape_v3.2.1/’. On Mac, ) and replace file ‘Cytoscape.vmoptions’ with file 

‘CoolMap_Reactome/Cytoscape/ Cytoscape.vmoptions’. Doing this is to change the 

maximum memory capacity for Cytoscape to 8G. For detailed instructions on how to 

increase the memory for Cytoscape on all platforms, please refer to 

http://wiki.cytoscape.org/How_to_increase_memory_for_Cytoscape.  

3. Now you can launch Cytoscape. The first time you launch Cytoscape, it will generate a 

configuration folder in your user home folder.  

4. Go to Cytoscape configuration directory (no matter what platform you use, this directory is 

at the user home folder, named ‘CytoscapeConfiguration’). Paste file 

‘CoolMap_Reactome/Cytoscape/reactomeFI-app-4.2.0-beta.jar’ to 

‘CytoscapeConfiguration/3/apps/installed/’. This will add the ReactomeFIViz plugin with 

our modifications for better CoolMap interoperability to Cytoscape.  

5. Install CyREST plugin for Cytoscape at http://apps.cytoscape.org/apps/cyrest. Our 

CoolMap application uses API provided by CyREST to pass data to and fetch data from 

Cytoscape.  

 

How to setup CoolMap to work with the R statistical environment? 

CoolMap needs to use Rserve to communicate with the R-statistical environment. CoolMap 

supports three different ways of Rserve setup. The required Rserve installation and initiating 

procedures are briefly described below. More details about Rserve setup and troubleshooting are at 

https://rforge.net/Rserve/doc.html .  

 

1. Local Rserve on the same computer that runs CoolMap  

The easiest way is to open an R session on the same computer on which you installed CoolMap. 

This particular R session can be closed after the Rserve is initiated since CoolMap will create a 

separate R session through the initiated Rserve. To start Rserve, type below commands at the R 

command prompt:  

install.packages("Rserve") # only needed for the first time installation  

library(Rserve)  

Rserve()  #on PC  

Rserve(args=’—no-save’) # on MAC OS  

Setting up Rserve locally on the computer running the CoolMap application is the preferred method 

since it enables seamless integration of visual data explorations in CoolMap views and R statistical 

analysis. R analysis results can be directly send to CoolMap for creating new CoolMap view or 
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overlay with the active CoolMap view for further exploration without saving R analysis results and 

reload them in CoolMap. 

 

The remote Rserve setup methods described below are only for sending large computation tasks to 

remote servers. Users need to load results from data files to CoolMap for additional exploration and 

analysis. 

2. Remote Rserve on a server in your network  

Setting up a remote Rserve on a server with more powerful processor, larger memory and storage 

can support large computing tasks, multiple users and file sharing among users.  

If you plan to setup remote Rserve, please install Rserve on a Linux core based OS so that the server 

can support multiple connections from different users. Windows version of Rserve only allows one 

connection at a time.  

You also need to configure Rserve to be able to answer queries submitted remotely by editing 

/etc/Rserv.conf and add a line ‘remote enable’ in it. To edit this file, you have to use the root 

privilege on the Linux server. To enable CoolMap on your computer to use the remote Rserve, you 

need to modify the config.json under CoolMap/plugin/r_plugin by changing default value 

“localhost” of property ‘server-url’ to the hostname or IP address (with the same double quotation 

marks as “localhost”) of the server on which Rserve runs.  

 

3. CoolMap Rserve service  

We setup CoolMap Rserve remote service for users with no access to high performance Rserve 

setup but want to perform computations not feasible on their own laptop/desktop computers. Only 

encrypted texts are used between users’ computers and the CoolMap Rserve remote service.  

To use this service with CoolMap on your computer, you need to delete the word ‘localhost’ inside 

the double quotation marks in the config.json file under CoolMap/plugin/r_plugin. 

 

How to setup CoolMap to work with the Integrated Genomics Viewer? 

The CoolMap application you downloaded has a built in communication functions to send data to 

IGV. You only need to launch the Integrated Genomics Viewer (IGV) on the computer you are 

running CoolMap. The IGV download and launch instructions are at 

http://www.broadinstitute.org/software/igv/startingIGV  

 

 

 

http://www.broadinstitute.org/software/igv/startingIGV
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How Do I Prepare My Data? 

 

Preparing Data for Importing into CoolMap 

 

CoolMap uses data in a variety of different formats to create the user’s heatmap canvas and 

ontology trees. Your data needs to be formatted correctly and in an allowable file format to be able 

to use within the program. The following sections detail the data formats supported = and how to 

import them into CoolMap.  

 

Data Format 

CoolMap is able to work with a variety of types of numerical data.  However, the data must be 

presented within a data matrix format, which represents the main constraint placed upon data 

formatting within CoolMap.  The data matrix format consists of an n-by-p matrix presentation of 

data in which n refers to the number of samples observed and p represents the number of variables 

measured.  Currently, the program supports three main file types:  

(1) Tab delimited file (.tsv, .txt): In this format, the cells are tab delimited, with the first row 

containing the column names and the first column containing the row names.  When 

using the tab delimited format, the ontology must be imported separately from the data.  

In addition, the user must make certain that no variable names are repeated within the 

file. 
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(2) Microsoft Excel file (.xls, .xlsx): This format is similar to the tab delimited file, except 

that the data can exist in multiple sheets and the ontology can be incorporated into the 

file. 

 

 

(3) NCBI GEO microarray (.SOFT): The Gene Expression Omnibus from the NCBI 

represents a public repository capable of distributing high-throughput genomic data and 

sequencing.  For the CoolMap program, this data must be imported via the SOFT, or 

Simple Omnibus Format in Text, which is a ‘flat’ tab-separated text file. 

 

Importing Data  

 

After opening the CoolMap program, select “File” from the menu bar and then click on “Import 

Data” in the dropdown menu which opens.  Depending on the file format for your data, you will 

select from one of three options for importing data:  

(1) Numeric tsv 

(2) NCBI.GEO soft 

(3) Numeric Microsoft Excel (xls, xlsx). 
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Ontology Format 

CoolMap supports four types of data for creating ontologies. 

1. The official OWL or OBO format: You can download ontologies in these formats from the 

OBO Foundry (http://www.obofoundry.org/ ) or other domain specific ontology web site. 

You may also create ontologies in these formats using tools such as protégé 

(http://protege.stanford.edu/ ). 

2. Simple two column format with parent node on the first (left) column and the child node on 

the second (right column). This is basically the Cytoscape SIF format 

(http://wiki.cytoscape.org/Cytoscape_User_Manual/Network_Formats ). In fact, CoolMap 

support both hierarchical tree and network structure to help the efficient exploration of large 

data matrix. 

3. Typical Microsoft Excel sample property/description file with the first column containing 

sample names and one or more columns containing sample property in different categories. 

The following is an example of such sample property file: 

 

 

http://www.obofoundry.org/
http://protege.stanford.edu/
http://wiki.cytoscape.org/Cytoscape_User_Manual/Network_Formats
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The Sample Property Table widget allows you to generate ontologies according to a sample property 

table you have created for your dataset. he table you create specifies the groups of your data in the 

dataset (e.g. by gender, visit, cohort, etc.) The groupings are specified in the columns of the table. 

The main function of the widget is to let you generate and display any possible categorical hierarchy 

from the column headings in your sample property table that you want. Once you decide what 

hierarchy you want to display as a CoolMap-generated ontology, you can select it for canvas display.  

 

When creating your sample property table file, the part of your table lists the sample and property 

names. The properties need to be defined as categorical or continuous.  

 

A categorical property has specific values and there are a set number of possible options for each 

sample. For example, a property titled “Gender” would be categorical, with two options, male or 

female. To designate a property as categorical when creating your sample property table, write it in 

the following form: 

 property name/cat 

A continuous property does not have fixed values to choose and each sample can vary in value. To 

designate a property as continuous when creating your sample property table, write it in the 

following form:  

 property name/con 

See the table below for an example of arranging a sample property table file and classifying the 

various properties as categorized or continuous.  

 

Sample Property Table File Example 

Sample ID/cat Gender/cat BMI/con 

001 Male 22.1 

002 Female 19.4 

003 Female 23.9 

004 Male 21.2 

 

 

4. Gene set file in the Broad Institute GSEA Gene Matrix Transposed file format (.GMT, 

http://www.broadinstitute.org/cancer/software/gsea/wiki/index.php/Data_formats#GM

T:_Gene_Matrix_Transposed_file_format_.28.2A.gmt.29 ). You can download .gmt files 

http://www.broadinstitute.org/cancer/software/gsea/wiki/index.php/Data_formats#GMT:_Gene_Matrix_Transposed_file_format_.28.2A.gmt.29
http://www.broadinstitute.org/cancer/software/gsea/wiki/index.php/Data_formats#GMT:_Gene_Matrix_Transposed_file_format_.28.2A.gmt.29
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from the Broad Institute Molecular Signatures Database 

(http://software.broadinstitute.org/gsea/msigdb/ ). 

 

Importing Ontology 

After opening the CoolMap program, select “File” from the menu bar and then click on “Import 

Ontology” in the dropdown menu which opens.  Depending on the file format for your data, you 

will select from one of the four options for importing ontology:  

 

 

You can further adjust the ontology created by an imported sample property table: 

4.1. Groups Within Categorical Properties 

You can view the groups contained (e.g. male and female) within a categorical property by right-

clicking on the column header of that property and selecting “View Groups”. The possible 

categorical groups will be listed.  

 

4.2. Groups Within Continuous Properties 

For continuous properties, the Sample Property Table automatically places all entries in one 

complete group, which goes from the sample minimum to maximum for that property. You can 

view or edit the groups within a continuous property by right-clicking on the column header of that 

property. To edit, select “Edit Groups”. You can then enter groups that differ from the default 

setting. When editing, simply enter values within your range and separate new groupings with a 

comma.  

http://software.broadinstitute.org/gsea/msigdb/
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4.3. Reordering Properties in the Sample Property Table 

By default, an ontology ontology generated from a sample property table will be ordered with the 

samples as the root, the highest level corresponding to the first property listed on the table (reading 

left to right), and proceeding downward from there.  

You can reorder the properties listed in your table by left-clicking on the column headers in the table 

to the left or right and dragging them into a new position. When you release the mouse button, the 

ontology you have created will be updated with this new hierarchical order of properties. This will 

be reflected in the Ontology Table. These changes will also show up in the Data Matrix and directly 

on the heatmap canvas if you have ontology rows placed onto the canvas.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 21 

 

 

 

 

 

Interacting with the Program 

 

Using the Top Menu Items 

The top menu items, listed horizontally in the top left corner across the top bar of the program, 

allow the user to control the program at a high level and in a multitude of different ways. Each item 

is described in greater detail in the following subsections. Each menu item is a drop-down list 

accessed by left-clicking the specific menu label. Many of the commands listed in the menus have 

their commands mapped to keyboard shortcuts. Each menu section contains a list of these 

shortcuts.  

 

File Menu 

The file drop-down menu includes commands to create new CoolMap projects and open existing 

ones. There are also commands to save the project currently opened and to import various data 

types into CoolMap. The final three commands, Import data, Import ontology, and Import ontology 

attributes, allow the user to import various data files for use within the program. These functions are 

described in the Importing Data section on page xx.  

 

 

File Menu Commands 

1. New project: create a new CoolMap project 
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2. Open Project: open an existing CoolMap project from a saved location 

3. Save: save your open project under its existing name 

4. Save As: prompts you to save your open project under a location and name you enter 

5. Import data: import a data matrix into CoolMap (see Section xx on page xx for a 

complete description) 

6. Import ontology: import an ontology dataset into CoolMap (see Section xx on page xx 

for a complete description) 

7. Import ontology attributes: import a supplementary ontology dataset into CoolMap (see 

Section xx on page xx for a complete description) 

 

File Menu Keyboard Shortcuts  

The following table lists the keyboard shortcuts available for the File Menu commands.  

 

File Menu Keyboard Shortcuts 

Command/Function Shortcut 

Create a New Project Control + Shift + N 

Open a Saved Project Control + O 

Save Project Control + S 

Save Project As Control + Shift + S 

 

 

Edit Menu 

The edit menu contains an undo command and two commands that allow you to save and load 

‘states’ of the program. The save and load state commands function as a large-scale undo button. 

This is useful to save your dataset when it is set one way, make changes to the heatmap arrangement, 

and re-load your original state to remove the entire series of changes.  

 

Undo/Redo Command 

The Edit Menu contains Undo/Redo command that can reverse many actions taken by the user. 

Due to the design of CoolMap and how certain widgets function, the Undo/Redo command only 

works for operations involving underlying data changes, not panning, zooming.  
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Save\Load\Remove State Commands 

The save state command saves a current version of your heatmap and program as it is currently 

arranged. The load state command loads your most recently saved state of the heatmap canvas. This 

is useful as a large-scale undo command. Returning to a previously saved state can remove multiple 

changes to the canvas display and arrangement with the click of a single button.  

Click “Save State …” will bring up a dialogue menu for naming the saved state. 

 

 

Click “Load State ..” will bring up a menu asking you to select one of the saved state for loading into 

CoolMap: 
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The Remove State commend can help you to remove unwanted state(s) from the saved states list. 

 

Edit Menu Keyboard Shortcuts  

The following table lists the keyboard shortcuts available for the Edit Menu commands.  

 

Table 3. Edit Menu Keyboard Shortcuts  

Command/Function Shortcut 

Undo Control + Z 

Redo Control + Y 

 

 

View Menu 

The View drop-down menu near the top left corner of the program gives you multiple ways to 

manipulate the view of the CoolMap canvas. Most of the commands in the View menu are mapped 

to keyboard commands to allow for quick adjustments without having to access the View menu. 

Many of these commands are also accessible from the Canvas widget. There are three options in the 

top level drop-down View menu : 

 

Reset Layout (Needs to Restart): To reset the layout of various panels to the default. It will 

restart CoolMap thus you should save your work by  go to “Edit/Save State …” first.  You probably 

do not need to use this function under most situations. 

Active CoolMap View: It is a dropdown menu containing functions controlling the display of the 

currently active CoolMap view. 
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Zoom In, Zoom Out, and Center Selection: The zoom in, zoom out, and center selection 

commands allow you to manipulate the direct view of the heatmap canvas. Zoom in and 

zoom out increase and decrease the size of the heatmap canvas, respectively. Center 

selection moves the canvas view to center over your current data selection on the heatmap. 

Sub-heatmap: When enabled, allows the user to see the underlying leaf tile (lowest level 

tiles) level data on a high level tile, which displays the aggregated value from all of its leaf 

level tiles.  
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The cell/tile size of the sub-heatmap annotations can be selected through “View->Active 

CoolMap View -> Sub-HeatMap -> Choose Size”   

 

 

Hoover Tooltip: When enabled, allows the display of row and column names as well as the 

value and aggregation type of the cell that mouse is currently hover over. 
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Neighborhood Tooltip: When enabled, display the names of the 5 neighboring rows and 

columns next to the CoolMap cell that mouse hovers over. 

 

 

 

Selection Tooltip: Display the row/column names for the selected region on the active 

CoolMap view. 
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Row Panel, Column Panel and their selections: Row and column panels are regions used 

for displaying ontology or clustering trees and row/column names. Users can also display 

other properties associated with rows or columns, e.g., t-test results for each gene in the 

rows, in a pane in the row/column panels. They are checked by default. 

Uncheck “All Maps” will remove the row or column panel completely.  

Uncheck “Label Pane” will remove the row or column label display pane. 

Uncheck “Ontology Pane” will remove the ontology tree display pane. 

 

 

 

 

 

Canvas: The canvas dropdown menu contains functions to adjust CoolMap canvas. 
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Show Widget Commands 

The Show Widget tab allows you to place widgets as you desire into the program. Many widgets do 

not automatically appear when the program is first started. However, the settings the widgets are in 

when the program is closed remain the same the next time CoolMap is opened. Please see the How 

Do I Utilize the Widgets section on page xx for specific information regarding the function and 

benefits of each of the widgets. The complete list of available widgets from the View Menu is shown 

below.  

 

 

 

View Menu Keyboard Shortcuts Summary 

The following table lists the keyboard shortcuts available for the View Menu commands.  

 

View Menu Shortcut Commands 

Command/Function Shortcut 

Zoom In Control + Plus 

Zoom Out Control + Minus 

Center Canvas Selection Control + Backspace 

Toggle canvas state Control + 1 

Toggle hover tooltip Control + 2 
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Toggle label tooltip Control + 3 

Toggle select tooltip Shortcut: Control + 4 

Toggle row panels Control + 5 

Toggle column panels Control + 6 

Arrange Maps -> Tile Control + [ 

Arrange Maps -> Cascade Control + ] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

How to Change and Manipulate Views in CoolMap 

View after Importing Data (correlation file) 

Once your data has been imported, a heatmap canvas will show up as a widget on the screen. 

Widgets make up the core of CoolMap, and are basically small windows containing different features 

of the program. These small windows show up automatically in two large main windows which can 

contain multiple widgets. 
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Interacting with Different Widgets and Panels 

All of the widgets in CoolMap can be moved and adjusted as desired.  

To move a widget or :  

1. Left-click on the top label bar of the widget and drag to your desired location within the 

CoolMap view.  

 

All panels and windows can be moved in the same way as individual widgets. Drag by left-clicking 

on the top bar of the respective panel or window. When moving a widget specifically, be sure to 

click on the label bar of that widget itself and not the entire top bar of the window the widget may 

be in.  

 

Adding Widgets to the Screen, Docking and Undocking, and Changing Size 

You can manipulate widgets in many ways outlined in the following sections.  

NOTE: You can adjust the size or position of the canvas the same way as any widget.  

 

To add a specific type of widget to your view: 

1. Go to View -> Show Widgets 
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2. Select the specific widget you wish to add to the screen 

3. The widget will appear in one of the windows on your CoolMap screen 

 

Closing a widget: 

1. Click on the ‘x’ located on the top label bar. 

 

Undocking a widget from a window (externalize): 

1. Press the externalize command, indicated by an arrow pointing out of a small square, located 

on the top left of the widget  

OR 

1. Right-click on the top label bar 

2. Select the externalize option from the drop-down menu 

NOTE: You cannot have two or more heatmap canvases undocked in separate views. All 

heatmaps stay contained within the canvas widget, but externalizing or minimizing the size 

of other widgets can give you as much as possible viewing area when using the canvas for 

more than one heatmap at a time.  

 

To dock a widget on a window (restore): 

1. Press the restore command, indicated by an arrow pointing to the center of a small square, 

located on the top left of the widget 

OR 

1. Right-click on the top grey bar of the widget 

2. Select the restore option from the drop-down menu 

 

To adjust the size of a widget when pinned to a window: 

1. Place the mouse icon over an edge of the widget 

2. Wait for the double-arrow icon to appear 

3. Left-click and drag the edge to the size you desire 

 

To adjust the size of a widget when it is externalized: 

1. Place the mouse icon over an edge or corner of the widget 

2. Wait for the double-arrow icon to appear 

3. Left-click and drag the edge to the size you desire 

NOTE: You can only adjust the size of a widget by moving the corner when it is in an 

externalized view.  
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Widgets can be maximized so they take up the entire CoolMap view.  

To maximize a widget: 

1. Press the square button located on the top left of the widget 

To restore the widget from a full-screen view: 

1. Press the restore button located on the top left of the widget (the same method as restoring 

an externalized widget) 

 

Navigating the Widgets 

All widgets are contained in the list within the View drop-down menu (described above). You can 

load as many widgets as you wish onto the CoolMap view, and place them how you desire into the 

side or bottom panels or into a window setup of your own. CoolMap remembers previous 

configurations of windows and widgets set up when the program is closed and reopened, so your 

personal setup of the program can be saved and reused at your convenience. However, if a widget is 

deleted from view and the program is closed, you will have to reopen this widget to use it again 

during your next CoolMap session.  

 

 

 

 

 

How to Utilize the Widgets 

The following section describes the various widgets and their functions within CoolMap. 

Aggregator   
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The aggregator widget allows you to adjust the aggregate values displayed on the CoolMap canvas 

when it is displaying ontologies or clusters of data. When displaying an ontology or cluster, the 

canvas defaults to showing the mean value of each node. With the aggregator, you can also display: 

1. Maximum  

2. Median 

3. Minimum (shown as Min) 

4. Sum 

5. Standard deviation (shown as SD) 

6. Variance (shown as Var) 

 

The aggregator widget also allows you to display the text information of a node or the network 

information of the node. Select ‘Text’ or ‘Network’ respectively to choose one of these options.  

 

 

Main Canvas  

 

The canvas of CoolMap contains the heatmap of data you have loaded. Along the top and right side 

the column and row labels are listed. They show the variables in the same order in rows and 

columns as you loaded from your spreadsheet or text file. To see the information displayed by a cell, 

simply hold the mouse icon over the heat map cell and a tooltip will appear.  

 

NOTE: the tooltip command can be toggled on or off. Please see the View Menu section (insert 

page #) to read how to do this.  



 35 

 

Canvas Command Buttons 

The canvas widget includes a row of commands that can be used to manipulate the canvas view in 

many different ways. These are located in the top left of the canvas, underneath the widget’s label 

tab.  

NOTE: An ‘X’ in a cell indicates missing data for that node.  

Zoom in or out: 

1. Press the + or – labeled magnifying glass buttons  

Center the view on your current data selection:  

1. Press the square button 

Edit the size of columns or rows of data on the canvas (Canvas Resize mode): 

1. Press the ruler button. This will put the canvas into Resize mode, with grid lines outlining 

the rows, columns, and individual cells of the canvas.  

2.  Select the column or row grid line you wish to edit with the double-sided arrow indicator 

3. To exit Resize mode and return the canvas to its normal state, simply press the ruler again 

Automatically resize data on the canvas:  

1. To incrementally increase or decrease the width of all columns at the same time, press the 

horizontal arrow command buttons. The arrows pointing outside increase the width and the 

arrows pointing towards each other decrease width.  

2. To incrementally increase or decrease the width of all rows at the same time, follow the exact 

same process as above, utilizing the arrow buttons that are oriented vertically.  

Restore column and/or row dimensions to their original size: 

1. Columns: press the double-line button located to the right of the column size adjustment 

buttons 

2. Rows: press the double-line button located to the right of the row size adjustment buttons 

 

Canvas Selection Commands 

You can select individual cells or whole rows or columns on the canvas in various ways. You can 

also quickly see the values of the selected data in the Data Matrix (described in a following section).  

 

To select a single cell, row, or column:  

1. Cell: Left-click on the desired data cell. 

2. Row or column: Left-click on the desired row or column label at the edge of the canvas.  

To select an entire row or column: 
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1. Left-click the column or row label above or to the right of the heatmap canvas. 

To select multiple cells that are not adjacent at the same time: 

1. Hold control and left-click. Click on all the desired cells. 

NOTE: this is only for adding individual selections to a group of selections. 

To select an area of adjacent cells, rows, or columns: 

1. Left-click the first cell you desire and shift-click a different cell.  

To select the intersection cell of a row or column: 

1. Select the entire row/column that contains the specific node you wish to select 

2. Select the opposing row/column (whatever is the opposite of your first selection) 

To deselect all data: 

1. Control-Click anywhere on the canvas 

OR 

2. Click in the grey background behind the canvas within the widget itself. 

NOTE: Clicking in space outside of the main canvas widget will not deselect your current 

selection on the heatmap. For example, clicking in the radar widget to move your canvas view 

will not deselect your current cell selection(s).  

 

 

Managing the Display of Row and Column Labels: 

The column and row labels on the top and right sides of the canvas can be adjusted as you desire to 

display data and ontology labels larger or smaller. You can increase the area that displays the row 

and column labels and ontologies. You can also adjust the label and ontology bars for both the 

column and row section to increase or decrease the amount of label and ontology information 

displayed.  

 

 

1 

1 

2 

2 
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Adjust the label area (light grey sections on the top and left edges of the canvas widget): 

1. Select the handle located in the light grey area with the labels. See the figure above, with the 

number 1 in red indicating both handles for the column and row label areas.  

2. Move the handle to adjust the respective label area to the size you desire 

Adjust the label bars: 

1. Place your arrow over a row or column label or ontology bar. See the figure above, where 

the number 2 indicates both the column and row label bars.  

2. Select the bar once the mouse indicator shows a double-sided arrow 

3. Slide the bar to your desired position 

 

Right-Click Commands 

Right-clicking anywhere on the canvas (within the data itself or within the grey background) allows 

you to manipulate the canvas in many ways. Due to the current state of CoolMap as a program still 

under development, not all right-click functions work properly. If a function does not work, it will 

be noted underneath the function description.  

 

Right click: 

1. Select: use the Select option to select all Columns or all Rows of data at once 

2. Expand: use the Expand option to expand a row or column to display all data within an 

ontology node. This only works on rows and columns displaying nodes above the leaf (or 

base) level. You can also use it to expand all rows or columns in the dataset at once.  

NOTE: Each expansion command expands the selection to one level lower than it currently 

is in the ontology. If the selection is already at the leaf node level, expanding will not change 

the row or column the selection is in.  

Expand options:  

1. Selected Rows/Columns 

This expands only the selected column or row, or the column or row of your 

current node(s) selected.  

2. Selected Rows/Columns to Leaf  

This expands the row or column of your current selection all of the way to the 

leaf nodes of your dataset.  

3. All Rows/Columns 

This expands all rows or columns on your canvas at the same time.  

3. Collapse: use the Collapse option to collapse a row or column of data into a cluster or its 

ontology. This only works on rows or columns displaying nodes below the highest level of 

the ontology. You can also use it to collapse all rows or columns in the dataset at once.  
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NOTE: Each collapse command collapses the selection to one level higher than it currently 

is in the ontology. If the selection is already at the highest level, collapsing will not change 

the row or column the selection is in.  

Collapse options: 

1. Selected Rows/Columns 

This collapses only the selected column or row, or the column or row of your 

current node(s) selected.  

2. All Rows/Columns 

This collapses all rows or columns on your canvas at the same time.  

4. Remove: use the Remove option to remove a selected row or column from the canvas.  

5. Copy Layout: use to copy the row or column of your current node selection. You can also 

select to copy both the row and column of your selection.  

6. Paste: use to paste a copied row or column layout to your currently displayed canvas. To 

paste, simply select the "Paste Layout" option after right-clicking on the canvas. 

 

You can also paste to nodes to the rows or columns directly from the Ontology Table 

widget. To paste directly from the Ontology Table: 

1. Highlight the rows in the Ontology Table you wish to copy 

2. Right-click and select "Copy selected nodes to clipboard" 

3. Right-click on the grey background 

4. Select your paste option. Choose "Nodes to column from Ontology Browser" or 

"Nodes to row from Ontology Browser". This will paste your copied nodes from 

the Ontology Table onto the front (top or left) edge of the columns or rows.  

7. Edit: the Edit option allows you to rename the CoolMap canvas. The name of the loaded 

dataset is the canvas name by default.  

8. Search Selected: search Pubmed, Google Scholar, or Google for your selected data. 

 

Sort Function 

The CoolMap canvas can be sorted in two ways, both manually and by using a right-click function. 

These are described following.  

 

Manual Sorting 

Manual sorting allows you to change the order the columns or rows are in. 

1. Left-click and hold the column or row label for the column or row you wish to move  

2. Continuing to hold left-click, drag the column or row to the specific spot you wish to place 

in your heatmap canvas 

Sorting Column or Row by Cell Values 

You can also sort a row or column by ordering the cells by their values.  
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1. Right click on the row or column label 

2. Choose Sort Ascending or Sort Descending. Sort Ascending orders the cell values from 

lowest to highest, and Sort Descending orders the cell values from highest to lowest.  

NOTE: Both sorting methods reflect their changes in the Data Matrix in the exact order. For more 

information on the Data Matrix widget, please see its description later in the Widget section.  

 

Console  

 

The console widget tells you CoolMap has been initialized and the corresponding processes behind 

that. This includes loading the various parts of the program, as well as showing you the file location 

the program initialized from and the file location the data was loaded from. This can be useful if you 

are having trouble finding the location of a data set on your computer.  

 

Data Linked to Active View  

 

The Data Linked widget displays the name of the currently active heatmap canvas. It can help you 

keep track of data selections when displaying multiple heatmaps at once in CoolMap. The up and 

down arrow buttons allow you to switch through multiple datasets and select which one you wish to 

be in the active canvas (instead of having multiple canvases open at once, for example.) You can also 

add or delete datasets from your active canvas view by using the plus and minus command buttons 

along the top of the widget. Press the plus or minus command and select the dataset you wish to add 

or delete from the list prompted by the command.  

 

Data Matrix  
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The Data Matrix displays all of the data in a spreadsheet table. Data you select in the heat map will 

be highlighted in the data matrix table. This also works the opposite way, data you select in the 

heatmap canvas will be automatically selected in the Data Matrix.  

CAUTION: the undo function does not work to reverse the following actions on the Matrix.  

 

To organize columns in the order you desire: 

1. Left-click on the column header and drag to a different place along the top bar. 

NOTE: When you reorder columns in this manner, the respective column in the heatmap 

canvas will move to that same position.  

To sort the Data Matrix columns: 

1. Left-click on the top label of the column you desire to sort 

2. Your first click will sort the column in ascending order (lowest value first) 

3. A second left-click will sort the column in descending order (highest value first) 

NOTE: Using the sort function on the data matrix will sort the data in the same order in the 

 heatmap canvas.  

4. To return the heatmap canvas to its original state, use the “Set rows to predefined sets” 

function in the Ontology Table widget. Please see the Ontology Table widget section for 

more information on this function.   

To copy data from the data matrix:  

1. Select the data cells you wish to copy, and right click on the data matrix table.  

2. Select “Copy selected data w/ headers to clipboard”.  
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NOTE: If you do a Select all -> copy and paste, the column and row headers will not be 

copied. 

 

Filter  

 

Use the Filter to create a statement to filter the heatmap by numerical values. 

CAUTION: the undo function does not reverse the Filter. To undo a Filter statement, click the 

Trashcan icon located on the individual filter within the Filter widget. However, manipulations 

made directly to the canvas while the filter was active will not be undone by using the Filter trashcan 

undo.  

 

To use the Filter: 

1. Use the pull down list to select the type of filter you want, Value Above or Value Below 

2. Press the + at the top right hand corner of the Filter widget. A filter box appears. The 

heatmap canvas will be automatically filtered to the default value entered in the box.  

3. Fill in your desired number.  

 

 

To add additional filters:  

1. Select the desired type of filter and press the +. Enter another numerical value in the new 

filter.  

2. Select if you want to “AND” or “OR” the different filter statements  

3. Apply the new filter by clicking the arrow drawn circle in the top right of the Filter widget.  
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NOTE: You may also filter the heatmap by using the color slider of the View Render tab. Please see 

the following section on the View Render for details on how to use this widget.  

 

Imported Data  

 

 

 

The Imported Data widget displays all dataset names that have been loaded into CoolMap during 

the entire duration of use since the last time the program was opened.  

 

 

Ontology Table  
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CoolMap will let you develop your own grouping of your data or automatically create groups for you 

based on the variable types in the columns of your datasets. These groups must be hierarchical and 

they are called ontologies.  

 

Benefits of the Ontology Table 

The ontology table allows you to view the ontology diagram of your dataset and gives you the ability 

to display the hierarchical (parent-child) relationships within your data.  

 

Canvas Display of Ontology Data 

You can display ontology data on the canvas and even replace the base data with ontology data if 

you want. When displaying ontology data that contains aggregates of the base data, the canvas 

displays the mean values of the child nodes automatically. This can be adjusted as desired.  

NOTE: In the ontology hierarchy, the high level grouping is called a parent node and the items 

grouped within it are called children nodes. The same child node may belong to different parent 

nodes at the same time.   

 

Parts of the Ontology Table 

 

 

The Ontology Table is broken into two main display sections, along with a row of command 

buttons and a search function along the top bar of the widget. These commands are described in a 

following section. The left panel of the widget, shown by the red number 1 in the figure above, 

displays an interactive diagram of the ontology you have loaded into CoolMap. The right panel, 

labeled with the red number 2 in the figure above displays an interactive data table containing 

information about the ontology.  

 

Left Panel: The Ontology Diagram 

The left panel of the ontology table displays a visual diagram of the ontology you select in the right 

panel. Selections you make in the corresponding data table will be displayed in diagram form, with 

1 2 
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parents displayed in various colors on the left of the selected node, while any children node will be 

displayed in different various colors on the left side. The figure below shows a parent node selected, 

with three children nodes displayed to the right.  

 

 

Right Panel: The Ontology Data Table 

The right panel is an interactive table that allows you to view information about different levels of 

the ontology and gives you the ability to change the displayed data on the canvas. The right panel 

table includes 6 columns which display various information about each node that is a part of the 

ontology. Nodes represent the different categorical items at various levels of the ontology and are 

essentially just groups of additional nodes or, on the base level of the ontology, nodes that contain 

specific data. Nodes above the leaf (base) level will display aggregate data for all the children nodes 

contained in it.  

 

It is easier to understand ontology's by discussing an example. An ontology on certain types of lipids 

might start with classifying each lipid as a Steroid Ester, a Long Chain Fatty Acid, or a Glycerol 

Lipid. These classifications are broken down further. The lipids can further be classified as 

Cholesterol esters, Triaglycerol, or many other possibilities. Only then, at the third level of the 

ontology, are the specific lipids named. So the lipid named CE14.0 is classified as a cholesterol ester, 

long chain fatty acid, and steroid ester. The leaf node has three parents above it in the ontology 

hierarchy.  

Not all leaf nodes will have the same number of parents. From this same example ontology, the lipid 

FFA14.0 is classified as a FFA Myristic Acid, belonging to Long Chain Free Fatty Acids. There is no 

higher classification above Long Chain Free Fatty Acids, so the leaf node FFA14.0 only has 2 parent 

nodes.  

 

A parent is a node that has several different nodes in the level below it in the hierarchical scheme of 

the ontology. A child is the actual node that belongs to the parent node. A node can have a parent 

node and have several of their own children, as well. An ontology breaks down from very general 

classifications at the top level to more and more specific classifications as you go down the various 

levels. The lowest level is made up of leaf nodes, which are the nodes that contain the actual 

variables from your dataset (your base data.) The highest level is called the root nodes of the 

ontology.  
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The columns in the table contain the information listed below.  

Node Name: displays the name of the specific node 

Child Count: displays the number of children nodes the specific node has 

Child Nodes: displays the names of all children nodes of the specific node 

Parent Count: displays the number of parents nodes the specific node has 

Parent Nodes: displays the names of all parent nodes of the specific node 

Depth: displays the number of “generations” a node has, or the subsequent children, 

grandchildren, great-grandchildren nodes, etc.  

 

 

 

Sorting columns: 

The columns can be sorted to display data in alphabetical or numerical order. When an ontology is 

first loaded into CoolMap, the ontology table automatically places the nodes in alphabetical order by 

their name. This can be helpful when deciding which ontology groups to add to the canvas 

(explained in the following section). 

 

Resorting by the numeric value of the children column can help you decide which rows to add to 

the canvas. For example, you can sort by number of children nodes have, select only those that have 

a number above 0 (if there is a 0 it means it is a leaf node), and add them to the canvas. To sort:   

1. Click on the column label of the column you wish to sort 

2. Clicking on the column label sort’s minimum to maximum with the first click. (Or 

alphabetically, beginning with letter ‘a’). 

3. Click a second time if you wish to reverse the order of sorting 

 

Adding Ontology Groups to the Canvas 

The top row of the Ontology Table includes a row of icons that allow you to manipulate the data 

displayed on the canvas in many different ways. All of the command icons display a brief description 

of their function when you hover the mouse icon over the icon for two seconds or so.  

 

 

Top Row Commands 

 

1 2 3 4 5 6 7 8 9 10 
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1. Set rows to predefined sets (Undo for rows):  

Use this if you wish to restore the original rows after you have added ontology 

categories or sorted the rows in some manner. It returns the rows to their original 

state. 

2. Set columns to predefined sets (Undo for columns):  

Use this if you wish to restore the original columns after you have added ontology 

categories or sorted the rows in some manner. It returns the columns to their 

original state. 

3. Prepend selected ontology nodes to rows:  

1. Select a group of ontologies to add to the canvas 

2. Press the button. The selected groups appear at the top of the rows in the 

canvas.  

4. Append selected ontology nodes to rows:  

1. Select a group of ontologies to add to the canvas 

2. Press the button to add your selected groups to the bottom of the rows in the 

canvas 

5. Replace rows with selected row nodes:  

1. Select a group of ontologies to add to the canvas 

2. Press the button to remove all current rows and replace them with the selected 

ontologies 

6. Replace rows with root ontology nodes:  

1. Select a group of ontologies to add to the canvas 

2. Press the button to remove all current rows and replace them with root 

ontologies 

7. Prepend selected ontology nodes to columns: 

1. Select a group of ontologies to add to the canvas 

2. Press the button. The selected group appears at the front (left) of the columns 

8. Append selected ontology nodes to columns: 

1. Select a group of ontologies to add to the canvas 

2. Press the button. The selected group appears at the front (left) of the columns.  

9. Replace columns with selected column nodes: 

1. Select a group of ontologies to add to the canvas 

2. Press the button to remove all current columns and replace them with the 

selected ontologies 

10. Replace columns with root ontology nodes: 

1. Select a group of ontologies to add to the canvas 

2. Press the button to remove all current columns and replace them with root 

ontologies 
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Radar  

 

The Radar widget shows where your view is located on the heatmap canvas. It functions as an 

interactive map that allows you to find your way around a large dataset very easily.  

 

To use the Radar: 

1. Click the Radar to move the white outline to a new location. The view of the heatmap 

canvas automatically moves with your radar selection. 

2. The Radar can be used if you lose sight of the heatmap. Simply click anywhere on the 

Radar view and your full-scale canvas view will return.  

NOTE: You cannot drag the white outline on the Radar view. You have to click to move it to a new 

location.  

 

Search  
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Use the Search widget to find specific items within your dataset. If the same item is on both the 

rows and columns, be sure to click the one you are specifically looking for. You can also click on 

more than one search result item to select all terms in the heatmap canvas.  

 

To select multiple items at once: 

1. Use Shift+Click to select all adjacent cells between your first and second selections  

2.  Control+Click to select multiple individual cells at once. Hold Control between selecting 

cells to hold on to previous selections.  

Deselect data in Search widget: 

1. Control-left click the highlighted row of data within the widget 

 

Syncer  

 

The syncer widget allows you to synchronize the actions between two or more heatmap canvases 

loaded into CoolMap at the same time. To utilize this widget, you must use datasets that share the 

same base nodes and terms for individual nodes. For example, if you have two datasets with the 

measures but for different groups, such as for male and female, or a before and after study 

measuring one property both times.  
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Syncer Functions 

To select the canvasses you wish to synchronize actions between, click the checked boxes by the 

listed names of all canvasses that are currently loaded by the program. The widget includes five 

options to synchronize various actions between your selected and synced canvasses. These are listed 

as five buttons in the top left corner of the syncer widget.  

 

 

 

1. Designate a Heatmap Anchor:  

This sets one canvas as the anchor between all of your selected and synced heatmaps. To set 

a map as an anchor, make sure it is your active selection by clicking somewhere within that 

canvas, and then select the anchor option on the top left of the syncer widget.  

2. Synchronize the Zoom function between canvasses.  

Clicking this option syncs the view zoom in and out level between all synced canvasses.  

3. Synchronize your Active Cell selection 

Clicking this option will synchronize individual node selections made on your anchor 

heatmap with all synced heatmaps displayed.  

NOTE: selections made on heatmaps that are not set as the anchor will not be displayed on 

other synced heatmaps.  

4. Synchronize Row Selections 

This function will take the row(s) of a data selection you make in one heatmap and select all 

corresponding rows in the rest of your synced heatmaps. For example, if you select an 

individual node in one map, the entire row of that node will be selected in the rest of your 

maps. If you were to select an entire column of data, every single row would be selected in 

the rest of maps.  

NOTE: selections with this with this function enabled do not need to be made on the 

anchor heatmap. They can be made on any of your synced heatmaps and all corresponding 

rows will be selected.  

5. Synchronize Column Selections 

This function will take the column(s) of a data selection you make in one heatmap and select 

all corresponding columns in the rest of your synced heatmaps. This function works exactly 

the same as the Synchronize Row Selections function, only it deals with corresponding 

columns of node selections and not rows.  

1 2 3 4 5 
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 NOTE: selections with this with this function enabled do not need to be made on the 

anchor heatmap. They can be made on any of your synced heatmaps and all corresponding 

rows will be selected.  

 

View Render  

 

The View Render widget allows you to change the display and the values shown on the heatmap 

canvas. It includes many features that allow you to customize your displayed canvas.  

 

The gradient editor: 

The gradient editor has three main functions available: Add Point, Edit Point, Remove Point. These 

allow you to add different levels of color to the gradient display on the heatmap canvas.  

Add points:  

Use this button to add a specific color point to the canvas color slide in the view render.  

1. Click Add Point, indicated by the plus sign. The new point automatically appears at the 0 

mark of the color slider. 

2. Slide the new point, shown as a new triangle on the slider, to adjust the color scheme as you 

desire 

3. Press the update button at the bottom to apply changes to the canvas 

Edit Points:  

Use this effect to edit the color shown by a point on the color slider 

1. Select the point you wish to edit on the slider 

NOTE: if you added a new point, this will be automatically selected by the view render when 

you click Edit Point 
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2. Click the color you want the point to be on the color table that appears on the screen.  

3. Press the Update button to apply changes 

Remove Point 

Use this effect to remove points you no longer wish to be on your custom gradient.  

1. Select the point you wish  

To use a Preset Palette color: 

1. Select the drop-down menu next to the Preset palette option 

2. Select the color scheme you wish to apply to the canvas 

3. Press the Update button to apply changes 

To show a preset range off values on the canvas: 

1. Select the drop-down menu next to the Preset range option 

2. Select the value range you wish to apply to the canvas. The options include: 

View min – max 

-1.0 – 1.0 

0.0 – 1.0 

-1.0 – 0.0  

0.0 – 100.0 

3. Press the update button to apply changes 

To manually enter a minimum or maximum value shown on the canvas: 

1. Add the desired number to either the Min value or Max value window 

2. Press the Update button to apply changes 

Draw a Sub-Heatmap: 

The View Render also contains the ability to draw sub-heatmaps for nodes that are a part of an 

ontology or cluster. A sub-heatmap shows all of the individual nodes that make up an ontology or 

cluster node.  

1. Select the box next to the Draw Sub-heatmap option 

2. Press the Update button 
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Plugins 

 CoolMap comes with many additional tools called plugins that allow you to interact with 

different software programs outside of CoolMap itself. These plugins give you the ability to share 

data and information between programs to add new levels of analysis possibilities to your work.  

 

Cytoscape 

Cytoscape is a free, open source software used to visualize complex networks and their associated 

pathways, while integrating these networks and pathways with annotations, node profiles and other 

state data. It was originally designed for biological research, making it very useful to integrate within 

CoolMap as the two programs can help a user to visualize the same set of data in multiple different 

ways, while comparing and contrasting it from these different perspectives.   

 

Using Cytoscape with CoolMap 

The Cytoscape plugin built into CoolMap allows you to map data selected in CoolMap and display 

these nodes in Cytoscape, as well as map data selected in Cytoscape into CoolMap. This can be 

extremely effective and helpful as a user to better understand a data set. When you select some data 

in the CoolMap canvas and want to see where these nodes are in the Cytoscape network, you can 

use the plugin to map these selections. 

 

Mapping Data to Cytoscape 

To map CoolMap selections into to Cytoscape: 

1. Select the “Plugin” drop down menu from the top bar of CoolMap 

2. Select “Cytoscape” 

3. Choose “Map nodes” 

4. Choose the mapping option you wish to see, with or without aggregated values 

All data selected in the heatmap canvas will now be highlighted in the Cytoscape node network 

display. 
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Mapping Data from Cytoscape 

To map nodes selected in Cytoscape to your CoolMap canvas: 

1. Select the “Plugin” drop down menu from the top bar of CoolMap 

2. Select “Cytoscape” 

3. Choose “Find Cytoscape Selection in CoolMap” (see this in the previous screen capture) 

All data selected in the Cytoscape node network will now be highlighted on the CoolMap canvas.  

Example Use Case  

To use the Reactome FI plugin optimized for interoperability with CoolMap, go to the Cytoscape 

“Apps” Menu  and select 'Apps->Reactome FI' and then click "Load Overall FI Network" and it 

will load all the FIs into a network. Now Cytoscape is ready for data passed in by CoolMap. 

Querying the FI network is through network connection but sometimes the Reactome web service is 

down, thus you may have to try later.  

The following is an example of exploring a data set in both CoolMap and Cytoscape. Steps 1 to 5 

take place in CoolMap while 6 in Cytoscape, and 7 is combination of both.  

1. Load data matrix: click ‘File->Import data->Numeric tsv’ and navigate to folder 

‘CoolMap_Reactome/CoolMap_Data’ and choose 

'Akil4_EntrezID_symbol_expression_symbol_only.txt'.  

2. Load row ontology: click ‘Analysis->Cluster->Hierarchical->Cluster Row’ to perform a clustering 

on rows. This takes 20-30 minutes because of the clustering libraries CoolMap depends on. We’re 

looking for some more efficient libraries to replace it.  

3. Load column ontology: click ‘File->Import ontology->Sample property table’ and navigate to 

folder ‘CoolMap_Reactome/CoolMap_Data’ and choose 'Akil4_iGRov_sample_description.txt' to 

load this property table into CoolMap and a new ontology will be generated in Ontology Table 

panel. Then you could see a new ontology generated in the Ontology Table panel, and click the 

'Replace columns with the root ontology nodes' button marked in the blue circle to apply the 

ontology to the rows. If the Ontology Table panel is invisible, click ‘View->Show Widgets-

>Ontology Table’ to make it visible.  
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4. Find patterns associated with long term GR activation in CoolMap.  

 

5. Select pattern regions on the data canvas(selected regions will be enclosed by white border 

rectangles and then click ‘Plugin->Cytoscape->Map nodes->Without aggregated values’ and these 

genes will be selected in the FI network in Cytoscape.  

6. In Cytoscape side, right click on the pathway event tree(on the left side) and choose ‘Analyze 

Pathway Enrichment->Genes from Selected Nodes’ and now you could see the enrichment results 

on the left panel and you can adjust the FDR threshold to view the interested pathways. Enrichment 

analysis is also through a web service reactome plugin provided.  

7. Select a pathway and right click on it, click ‘Generate FI Network with Hit Genes->With Genes 

Used by Enrichment Analysis’ to view the pathway diagram as well as the FI Network, and the blue 

genes are from CoolMap. Purple genes in Curated Reactome TFG-beta signaling pathway are from 

CoolMap. Researchers can select genes in their neighborhood (highlighted by blue squares) and send 

it to CoolMap to examine their sample level data. Sending genes back to CoolMap can be done by 

Click menu item ‘Plugin->Cytoscape->Find Cytoscape Selection in CoolMap’ in CoolMap.  



 
 

 Work with R Statistical Environment in CoolMap 

The R plugin for CoolMap is designed to provide statistical analysis capability for data displayed in 

CoolMap and the display of analysis results directly in CoolMap.  

CoolMap comes with R plugin as default. The R plugin folder is placed under 

CoolMap/plugin/r_plugin. If you somehow uninstalled or broke the R plugin, download it again on 

the CoolMap website (coolmap.org) and place it under the CoolMap plugin folder.  

The CoolMap R plugin requires the running of Rserve, which enables the communication between 

CoolMap and the R statistical environment.  

 

Use Pre-Bulit R Analysis Functions in CoolMap  

After R plugin setup, you will see available analysis functions under the Analysis menu. The analysis 

function list is derived dynamically from the R scripts stored under folder CoolMap/plugin/r_plugin 

/scripts.  

To use a function, just click it in the Analysis menu. A graphic user interface will pop-up for you to 

select the data from the CoolMap view at current focus and related function parameters. The 
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graphic user interface allows users to perform analysis using pre-built functions without writing R 

scripts.  

 

Example 1: Matrix t-test  

The following is the GUI data analysis dialog window generated from R script 

CoolMap/plugin/r_plugin/scripts/analysis/matrix.t.test.R.  

 

 

You can import matrices required for the analysis from CoolMap canvas and they will be listed in 

the top left box of the dialogue window. You can also change the names of these matrices by double 

clicking on the matrix name.  

The dialogue box below the matrices list is the parameter table where you can tune the function 

parameters. By hovering over the parameter names, you can see the description of the parameter. 

Note there is a special parameter named ‘result.name’. It is where you specify a name for the result 

variable of the analysis function, thus you can access the result by this variable in ‘R Console’, which 

will be detailed later in this manual. The top right box contains the output of the analysis function. If 
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an output variable corresponds to row or columns nodes on CoolMap canvas, you can further map 

them to the row/column highlightor by right clicking on these variables listed in ‘Analysis Result’. In 

this case, after a t-test, the resulted p-value of the function can then be highlighted to the 

row/column to facilitate data exploration in CoolMap.  

Example 2: Hierarchical Clustering  

Below is the dialog window for hierarchical clustering.  

 

This dialog was generated by R script matrix.hclust.R under 

CoolMap/plugin/r_plugin/scripts/cluster/. The upper half of the dialog lists all the parameters you 

have to set. By hovering over the parameter names, you can see the description of the parameter. 

Note there is a special parameter named ‘result.name’. It is where you specify a name for the result 

variable of the clustering function, thus you can access the result by this variable in ‘R Console’, 

which will be detailed later in this manual. The bottom half of the dialog is the description of the 

clustering function. After setting all the parameters in the ‘Value’ column, just press the perform 

cluster button to perform the clustering function and the data in the CoolMap will be clustered.  

Parameter ‘data’ can be set to ‘whole_dataset’ which means the clustering will be conducted on the 

whole dataset in the current CoolMap canvas, or ‘selected_region” to perform clustering on the 

selected matrix in CoolMap canvas.  

Parameter ‘row.clustering’ can be set to ‘TRUE’ to perform the clustering based on data in rows. 

When it is set to ‘FALSE’, the clustering will be based on data in columns.  

The rest of the parameters and their selections are the same as the standard R hclust function.  
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The clustering results will be directly drawn on the row or column side of the selected data region in 

the CoolMap view if leave ‘Create new window’ unchecked, otherwise, a new CoolMap view with 

the data specified by parameter ‘data’ will be created first and then clustered.  

 

Write custom R Analysis Functions for Sharing  

The CoolMap program can automatically generate a graphic user interface for each analysis function 

based on the parameter list and the output list described in each analysis function. As a result, users 

can write custom analysis functions in R and put them under CoolMap/plugin/r_plugin /scripts 

without writing GUI for each function.  

Users can follow standard R function writing rules with two additional requirements 1) list all the 

parameters that may need user selection/input in the function name line 2) list all function outputs 

in the last line of the function as a R list. Examples of pre-built functions can be found under 

CoolMap/plugin/r_plugin /scripts. Naturally, it is straightforward to share pre-built R scripts for 

CoolMap among different users.  

 

Use the integrated R Console in CoolMap  

The command line R console, accessible through the Plugin->R->R console menu item, can be used 

for more flexible data manipulation. You can import the whole matrix in CoolMap or selected 

region on the a CoolMap view as R matrix, run R statements in the R command input area and get 

results in the R command output area at the bottom of the R console window (see screen capture 

below).  

A common need for the CoolMap R Console in the Windows environment is to adjust memory 

available to the CoolMap R Console. You can use the ‘memory.limit(M)’ with M be the number of 

megabytes needed. You can also run ‘gc()’ to free the memory so that you can get more memory for 

your analysis.  

Since all R analyses in a CoolMap use the same R session, all data objects created by the pre-built 

analysis functions are also accessible through the command line R console. As a result, this R 

console is useful for the examination of various data objects and quick ad hoc analysis. You may also 

close and reopen the R console window under the same Rserve() connection and reuse all data 

objects imported or created in the previous R console window.  
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The CoolMap R console behaves very similarly to the standalone R console except 1) it only display 

the results (including matrix) in one line in the bottom window 2) for some commands the return 

string may be different from the standard R console. Making the R console output as close to the 

standalone R console as possible will be a goal of our next phase of development.  

You can use R packages you installed previously on your computer as well as using the R graphics 

functions, although the resulting R graphics is not connected to CoolMap views. One issue under 

the Windows environment is if R Graphics pop-up window is initially hidden behind windows of 

other programs, Windows may fill the R Graphics window even if you bring it to the front by 

clicking the icon on the Windows task bar. Under this situation, you only need to rerun the R 

graphic again.  

The Variable window at the upper right corner of the R console window serves two important 

purposes. Firstly, it is the graphic interface for the R ‘objects()’ function and it can be used to search 

all existing R data objects. You can type in the object pattern string in the data entry box on the left 

of the “Search” button. Secondly, it provides a way to send the selected variable to create a new 

CoolMap view or to modify the currently active CoolMap view. Right clicking a variable in the 
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Variable Inspector window will bring out a pop-up menu that provides three operations for the 

variable:  

Send selected to the CoolMap (must be a matrix)  

Highlight selected to column  

Highlight selected to row  

As a result, you can use ad hoc R analysis results to refine CoolMap-based data exploration 

iteratively. 
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Reference Guide 

CoolMap Terminology 

Some terms used throughout this manual are unique to CoolMap. The following lists explains some 

of the commonly used phrases and terms for the program.  

 

Base Data: data that are stored in a table format. Base data can be imported to CoolMap from 

tables files such as .tsv and .xls, and they will remain unchanged throughout use in CoolMap. 

 

CoolMap View: the CoolMap view or canvas is the visual representation of one or more entries of 

base data. The rows and columns in a CoolMap view can be ordered differently than the base data. 

The view can be changed by user operations (sorting, dragging, etc.) or programmatically (clustering, 

node expansion, collapse, etc.) 

 

Node: a node indicates a row or column entry. There are two types: base node and ontology node 

 Base node: leaf nodes that can be mapped directly to rows and columns in the base data. 

 They can’t be expanded but can have multiple parent nodes. 

 Ontology node: can be expanded or collapsed and can have multiple parent or child nodes. 

 CoolMap’s ontology tree is designed as ‘Multiple Inheritance’ as it is required in biological 

 sciences. For example: a gene can belong to multiple KEGG pathways or be associated with

 many Gene Ontology (GO) terms.  

Levels of Ontologies: Ontology levels can be referred to with some basic terminology  

 

Aggregator: An aggregator creates a way to generate an ‘aggregate’ value as a representative entity 

for the group of entities contained in an ontology node, when a CoolMap view is presenting 

ontology nodes (which contain multiple base nodes). For example: the mean value can be used to 

represent a group of numeric values, or a IUPAC consensus letter can be used to represent a group 

of aligned nucleotides. CoolMap is preloaded with frequently used numeric aggregators like mean, 

meadian, min, max, etc.   

 

Renderer: A renderer determines how the values in the CoolMap view are represented. Values can 

be represented using color, shape, or statistical plots. CoolMap makes it very easy to define custom 

renderers through plugin development. 
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Widget: Widgets are features within the program that show as boxes within the main windows of 

the program interface. These can be moved around to customize the setup of CoolMap for the 

individual user.  

Frequently Used Keyboard Commands 

Command/Function Shortcut 

Create a New Project Control + Shift + N 

Open a Saved Project Control + O 

Save Project Control + S 

Save Project As Control + Shift + S 

Undo Control + Z 

Quick Save State Control + M 

Quick Load State Control + L 

Zoom In Control + Plus 

Zoom Out Control + Minus 

Center Canvas Selection Control + Backspace 

Toggle canvas state Control + 1 

Toggle hover tooltip Control + 2 

Toggle label tooltip Control + 3 

Toggle select tooltip Shortcut: Control + 4 

Toggle row panels Control + 5 

Toggle column panels Control + 6 

Arrange Maps -> Tile Control + [ 

Arrange Maps -> Cascade Control + ] 

 

 

 

 

 


